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About This Guide

Purpose
This manual describes the components of the ICM Alarm process and provides
Information about the ICM /SDDSN AlarmEx MIB definition. 

Note The Standalone Distributed Diagnostics and Service Network (SDDSN) is a 
sub-component of the ICM system, which provides a mechanism for “phone 
home” services and generating SNMP traps. It is intended to be integrated into 
other products (i.e. Cisco ISN) to provide event reporting capability. The 
SDDSN component uses a portion of ICM Logger functionality. Some product 
specific files (message DLLs, filter files, etc.) and registry entries are also used 
to add SDDSN support. 

Audience
This manual is intended primarily for ICM system administrators responsible for 
maintaining the ICM Alarm process.

Conventions
This manual uses the following conventions.
v
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About This Guide
Organization
Organization
The manual is divided into the following chapters.

Other Publications
For additional information about Cisco Intelligent Contact Management (ICM) 
software, see the Cisco web site listing ICM documentation.

Format Example

Boldface type is used for user 
entries, keys, buttons, and folder 
and submenu names.

Choose Edit > Find from the ICM 
Configure menu bar.

Italic type indicates one of the 
following:

• A newly introduced term

• For emphasis

• A generic syntax item that 
you must replace with a 
specific value

• A title of a publication

• A skill group is a collection of agents 
who share similar skills.

• Do not use the numerical naming 
convention that is used in the 
predefined templates (for example, 
persvc01).

• IF (condition, true-value, false-value)

• For more information, see the Cisco 
ICM Software Database Schema 
Handbook.

An arrow ( > ) indicates an item 
from a pull-down menu.

The Save command from the File menu is 
referenced as File > Save.

Chapter Description

Chapter 1, “ICM Alarm 
Components”

Describes the components of the ICM Alarm 
process and procedures for setup and 
configuration.
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About This Guide
Obtaining Documentation
Obtaining Documentation
The following sections provide sources for obtaining documentation from Cisco 
Systems.

World Wide Web
You can access the most current Cisco documentation on the World Wide Web at 
the following sites:

• http://www.cisco.com

• http://www-china.cisco.com

• http://www-europe.cisco.com

Documentation CD-ROM
Cisco documentation and additional literature are available in a CD-ROM 
package, which ships with your product. The Documentation CD-ROM is updated 
monthly and may be more current than printed documentation. The CD-ROM 
package is available as a single unit or as an annual subscription.

Ordering Documentation
Cisco documentation is available in the following ways:

• Registered Cisco Direct Customers can order Cisco Product documentation 
from the Networking Products MarketPlace:

http://www.cisco.com/cgi-bin/order/order_root.pl

• Registered Cisco.com users can order the Documentation CD-ROM through 
the online Subscription Store:

http://www.cisco.com/go/subscription

• Nonregistered Cisco.com users can order documentation through a local 
account representative by calling Cisco corporate headquarters (California, 
USA) at 408 526-7208 or, in North America, by calling 800 
553-NETS(6387).
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About This Guide
Obtaining Technical Assistance
Documentation Feedback
If you are reading Cisco product documentation on the World Wide Web, you can 
submit technical comments electronically. Click Feedback in the toolbar and 
select Documentation. After you complete the form, click Submit to send it to 
Cisco.

You can e-mail your comments to bug-doc@cisco.com.

To submit your comments by mail, use the response card behind the front cover 
of your document, or write to the following address:

Attn Document Resource Connection
Cisco Systems, Inc.
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Obtaining Technical Assistance
Cisco provides Cisco.com as a starting point for all technical assistance. 
Customers and partners can obtain documentation, troubleshooting tips, and 
sample configurations from online tools. For Cisco.com registered users, 
additional troubleshooting tools are available from the TAC website. 

Cisco.com
Cisco.com is the foundation of a suite of interactive, networked services that 
provides immediate, open access to Cisco information and resources at anytime, 
from anywhere in the world. This highly integrated Internet application is a 
powerful, easy-to-use tool for doing business with Cisco.

Cisco.com provides a broad range of features and services to help customers and 
partners streamline business processes and improve productivity. Through 
Cisco.com, you can find information about Cisco and our networking solutions, 
services, and programs. In addition, you can resolve technical issues with online 
technical support, download and test software packages, and order Cisco learning 
materials and merchandise. Valuable online skill assessment, training, and 
certification programs are also available.
viii
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About This Guide
Obtaining Technical Assistance
Customers and partners can self-register on Cisco.com to obtain additional 
personalized information and services. Registered users can order products, check 
on the status of an order, access technical support, and view benefits specific to 
their relationships with Cisco.

To access Cisco.com, go to the following website:

http://www.cisco.com

Technical Assistance Center
The Cisco TAC website is available to all customers who need technical assistance 
with a Cisco product or technology that is under warranty or covered by a 
maintenance contract.

Contacting TAC by Using the Cisco TAC Website

If you have a priority level 3 (P3) or priority level 4 (P4) problem, contact TAC 
by going to the TAC website:

http://www.cisco.com/tac

P3 and P4 level problems are defined as follows:

• P3—Your network performance is degraded. Network functionality is 
noticeably impaired, but most business operations continue.

• P4—You need information or assistance on Cisco product capabilities, 
product installation, or basic product configuration.

In each of the above cases, use the Cisco TAC website to quickly find answers to 
your questions. 

To register for Cisco.com, go to the following website:

http://www.cisco.com/register/

If you cannot resolve your technical issue by using the TAC online resources, 
Cisco.com registered users can open a case online by using the TAC Case Open 
tool at the following website:

http://www.cisco.com/tac/caseopen
ix
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About This Guide
Obtaining Technical Assistance
Contacting TAC by Telephone 

If you have a priority level 1 (P1) or priority level 2 (P2) problem, contact TAC 
by telephone and immediately open a case. To obtain a directory of toll-free 
numbers for your country, go to the following website:

http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml

P1 and P2 level problems are defined as follows:

• P1—Your production network is down, causing a critical impact to business 
operations if service is not restored quickly. No workaround is available.

P2—Your production network is severely degraded, affecting significant aspects 
of your business operations. No workaround is available.
x
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Cisco ICM
OL-0720-02
C H A P T E R 1

ICM Alarm Components

This document describes the components of the ICM Alarm process and provides
Information about the ICM/SDDSN AlarmEx MIB format.

The ICM / SDDSN Alarm capability is made up of a set of alarmable objects 
within the Cisco ICM system or SDDSN system.

Alarms are error or warning events generated by ICM / SDDSN processes and 
delivered to a network management station (NMS). An alarmable object is a 
component (hardware or software) that can fail or malfunction.

Typical alarmable objects are:

• PC Nodes,

• processes,

• communications connections,

• peripherals (ACDs),

• sessions to ACDs, etc.

Event Feed Process
Alarms are derived from the event message stream continually being generated by 
the various Cisco processes throughout the system. These processes report events 
of interest to the central database or SDDSN as they occur. Just before being 
placed in the central database, the event stream is intercepted by a process (CSFS) 
that watches for events of significant interest which should be treated as alarms.
1-1
 Software Alarm MIB User Guide



Chapter 1      ICM Alarm Components
Event Feed Process
The CSFS process generates an event feed to the Cisco SNMP Extension agent 
(AlarmEx), which has an interface to the Windows SNMP agent. The Windows 
agent generates an SNMP feed that sends SNMP traps over an IP connection, 
where the NMS receives and processes alarm data (Figure 1-1). 

The AlarmEx feed has a heartbeat mechanism that generates a periodic trap to 
indicate that the ICM Event Feed to the SNMP trap agent is functional.

Figure 1-1 Figure 1-1 ICM Alarm Process

ICM/SDDSN SNMP Extension Agent
The ICM/SDDN SNMP extension agent is AlarmEx.dll. This DLL is installed on 
the ICM Logger and/or the SDDSN server.

This extension agent closely matches the alarm model that is used by Alarm 
Tracker. It receives an EMS event feed from the CSFS process and interfaces to 
the Windows NT SNMP Agent to generate SNMP traps when “alarmable” events 
occur. These events are “statefull”, meaning that there is an object associated with 
a set of events. The object’s state can indicate a failure (Raise) or a non-failure 
(Clear), depending on the current event associated with that object. The SNMP 
Extension Agent allows customers with an SNMP based Network Management 
Station (NMS) such as Cisco Works 2000, HP OpenView, CA Unicenter TNG, 
Tivoli Enterprise, or Aprisma Spectrum to receive SNMP traps mapped to key 
EMS events.
1-2
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Chapter 1      ICM Alarm Components
Event Feed Process
Note In order to correctly interpret the Cisco generated trap messages, the version 
of the ICM SNMP MIB (ALARMEX.MIB for ICM 5.0 or ICRALARM.MIB 
for legacy systems) which corresponds to the ICM version must be loaded into 
the NMS. Additionally, if another product, such as the Cisco ISN system, is 
being monitored using this extension agent, then the appropriate MIB for that 
product must be also be loaded into the NMS.

The configuration of the SNMP Extension Agent is automated by ICM Setup. 

To enable the SNMP feed on the Logger:

Step 1 Run ICM Setup. Select the Logger from the Customer Components list and click 
the Edit button, or, if adding a new logger, click the Add button and then click the 
Logger button on the ICM Component Selection screen. 

Step 2 Click Next from the Logger Properties window. The Logger Component 
Properties window displays: 

Step 3 In the SNMP Feed section, check the Enabled box.

Step 4 Click the Configure button. the SNMP Feed Configuration window displays.
1-3
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Chapter 1      ICM Alarm Components
Event Feed Process
Check the Use legacy SNMP agent to use the sub-agent that came with ICM 4.x. 
software. This allows you to continue using any optional rules that you have 
written for your NMS. Use the ICRALARM.MIB with the legacy sub-agent. If 
you leave this box unchecked, you will enable the more extensive SNMP 
sub-agent that comes with 5.x or later. Use the ALARMEX.MIB with the new 
sub-agent. The advantage of the new sub-agent is that it more closely represents 
the alarms that would be seen in the RMS-AlarmTracker product.

Note Cisco strongly recommends that you use the most current SNMP agent, unless 
you have legacy rules that prevent you from doing so. If you use the legacy 
SNMP agent, refer to the appropriate documentation for the version of the 
agent that you are using.

Check the Enable suppression option to suppress repeat events. This features 
works exactly as the suppression option for CSFS / DTP. It suppresses repeat 
events based on the configuration of the “phone home” component. 

Note Use DTP suppression for SNMP alarms. This matches the suppression 
configured for phone home, if enabled. Otherwise the default of 5 repeat 
events per hour is used.

Click the OK button.

Continue until the Logger setup is complete. 

For information on the Logger setup, see the Cisco ICM Software Installation 
Guide.

Windows 2000 SNMP Agent Configuration
The following Windows 2000 service is required to enable the exportation of ICM 
traps via the ICM Extension Agent:
1-4
Cisco ICM Software Alarm MIB User Guide

OL-0720-02



Chapter 1      ICM Alarm Components
Event Feed Process
• the SNMP Service.

Note SNMP is always installed on Windows 2000 system.

The SNMP Service must be configured to send SNMP traps to the desired 
management stations. 

To configure traps for the SNMP service:

Step 1 Open the Windows 2000 Control Panel.

Step 2 Select the Administrative Tools sub-directory and click on the Services icon.

Step 3 Right click on SNMP Service and select Properties from the list. The SNMP 
properties screen displays:

Step 4 Click on the Traps tab. Enter “public” in the community name field and click the 
Add button.

Note “Public” is used here as an example. Check with your IT representative for the 
proper security needed for your particular SNMP implementation.
1-5
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Chapter 1      ICM Alarm Components
Event Feed Process
Step 5 Click the Add button under Trap Destinations and enter the IP host address (or 
host name) or IPX address of the management network station that you want to 
receive traps. Click the Add button. Repeat this step for each address you want to 
add.

Step 6 Click the OK button when you are finished adding the addresses.

Note Any changes you make in the SNMP configuration screen will not take effect 
until the SNMP service is restarted. 

The SNMP Service should be configured for “automatic” startup to allow it to run 
automatically after each system reboot. This should be checked once the ICM 
Extension Agent has been installed and configured through ICM Setup.

Note Refer to the Microsoft support website for information about SNMP updates.

How to use the MIB

The following table contains a MIB excerpt that describes the required fields that are 
supported by each trap event.

Note This table applies to the new sub-agent using the ALARMEX.MIB.
1-6
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Chapter 1      ICM Alarm Components
Event Feed Process
Table 1-1 Required MIB Fields

Field Type Description

objectIdentifier DisplayString 
(SIZE(1..256))

The unique identifier used to 
relate events as objects. Use this 
to map multiple 

trap events to a single object. 
This allows for an 
object-oriented status similar to 
AlarmTracker.

objectState INTEGER

clear(0),

application-error(2), 
raise(4),

single-state-raise(9)  

The state of the unique object. 
Clear indicates an up condition, 
Raise indicates a down 
condition. Use this to track the 
state of the object indicated by 
objectIdentifier value.

messageId DisplayString 
(SIZE(1..12))

The EMS MessageId value in 
hexadecimal format. The trap 
number is derived from the 7 
least significant hex digits. 
They are then converted to 
decimal to create the trap 
number.

originatingNode DisplayString 
(SIZE(1..32))

The node name indicates where 
the alarm orginated, and is a 
combination of the computer 
name and customer name or 
instance, in the format of 
computer\customer. 
1-7
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Chapter 1      ICM Alarm Components
Event Feed Process
originatingNodeType INTEGER 

unknown(0),

router(1), 

pg(2), 

nic(3),

aw(4),

logger(5),

listener(6),

cg(7),

ba(8)

The type of ICM node that 
originated this alarm. For 
system other than the ICM, this 
value is always 0.

originatingProcess DisplayString 
(SIZE(1..32))

The name of the process that 
originated this alarm.

originatingSide DisplayString 
(SIZE(1))

The side ('A' or 'B') that 
originated this alarm.

dmpId INTEGER(0..255) For systems other than the ICM, 
this value is always 0.

severity INTEGER 

trace (0),
informational (1),
warning (2), 
error (3)

The severity of this alarm. The 
severity is contained as a bit in 
the most significant hex digit of 
the EMS Message ID:

- a value of 0xE indicates 
“error”

- a value of 0xA indicates 
“warning” 

- a value of 0x6 indicates 
“informational”

- a value of 0x2 indicates 
“trace”

Table 1-1 Required MIB Fields (continued)

Field Type Description
1-8
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Chapter 1      ICM Alarm Components
Event Feed Process
The following MIB excerpt describes the optional fields that are supported by 
each trap event. There can be up to 5 entries of this type.

Sample MIB Entry

EmsgTimnicSockConnectFailed TRAP-TYPE

ENTERPRISE alarmsv2

VARIABLES {

objectIdentifier,

objectState,         -- Raise

messageId,           -- 0xE14D0017

originatingNode,

originatingNodeType,

originatingProcess,

originatingSide,

timestamp DisplayString 
(SIZE(17))

The time at which the alarm 
originated, in the format 
YYYYMMDD HH:MM:SS (24 
hour time).

fullEventText DisplayString 
(SIZE(1..2047))

The full text of the event that 
generated this alarm. This is 
made up of a fixed string and 
substitution parameters. For 
example, “System%2 
connected to System%1”

Table 1-1 Required MIB Fields (continued)

Field Type Description

Table 1-2 Optional MIB Fields

Field Type Description

substitutionArg DisplayString 
(SIZE(1..256))

Substitution parameters used to 
create the full text description. Up 
to 5 parameters. These are known 
as EMS arguments 1..5

This would correspond to the%n 
arguments where n is 1 to 5.
1-9
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Event Feed Process
dmpId,

severity,

timestamp,

fullEventText,

substitutionArg,  -- EMS argument %1

substitutionArg,  -- EMS argument %2

substitutionArg   -- EMS argument %3

}

DESCRIPTION 

"TIM NIC was unable to 

connect to the GATEWAY 

on the INAP network."

--

-- ACTION 

-- "Confirm GATEWAY is available, 

-- Configuration of IP address and

-- Port are correct, and Network 

-- connectivity would allow for

-- connection."

--

-- SUBSTITUTION STRING 

-- "Session for GATEWAY[%1] Connect

-- FAILED to GATEWAY on Port %2

-- using Address %3."

--

-- OID VARIABLES (used to create 

 objectIdentifier) 

-- { 4 7 12 }

                    --

::= 21823511      -- 0x14D0017

Each entry indicates the state as a comment, for example, " – Raise ". 

The event Message ID is also supplied as a comment, for example,  " – 
0xE14D0017 ".

Each EMS argument is listed for reference as a comment to the substitutionArg 
parameter.

The DESCRIPTION, ACTION, AND SUBSTITUTION STRING match the 
online help documentation for the product. You can lookup this information in the 
Alarm helpfile using the hexadecimal Message ID value.
1-10
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Chapter 1      ICM Alarm Components
Location of the ICM Alarm MIB
OID VARIABLES is a list of entries that numerically correspond to the fields in 
the trap. For example, a value of '4' corresponds to the fourth item which is 
'originatingNode'. This list of parameters is used to help create the unique 
objectIdentifier string value.

Finally, the trap id is derived from the lower 7 hexadecimal digits as represented 
in decimal notation.

Location of the ICM Alarm MIB
The ICM Alarm MIB is installed when you install the Logger component. When 
the Logger is installed the MIB (ALARMEX.MIB) is located in the \ICM\Bin 
directory on the logger node. 

Note If you have chosen to use the legacy sub-agent, the ICRALARM.MIB is also 
located in \ICM\Bin directory on the logger node.

You must copy the MIB to your NMS for compilation. If using SDDSN, you also 
need to copy the product-specific MIB. Refer to the product documentation for 
information regarding the location of the product-specific MIB.
1-11
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